Using Qualtrics Effectively

by Debby Kermer

George Mason University Libraries

Digital Scholarship Center
Use the Help

Visit Qualtrics University

What can we help you with?

Select a support topic

Survey Platform

https://www.qualtrics.com/support/
Tutorials

Learn Qualtrics in 5 Steps

If you are looking for a quick crash course on Qualtrics, try the 5 step program. The program takes 1-2 hours to complete and will teach you how to design, distribute, and report on a survey. Each step consists of a video (or text if you prefer) and a project. Click the button below to get started!

Help is available in:

✓ Video
✓ Text (with Screenshots)

See also tips on creating surveys:

https://www.qualtrics.com/blog/topic/surveys/

https://www.qualtrics.com/support/survey-platform/getting-started/survey-platform-overview/
Navigation
Main Screen

After you have created a project, this will be the landing screen when you log in.

You can organize your projects in folders if you wish. Look in folders if you cannot find a project that has been shared with you.

To get to this screen, choose Projects from the primary navigation or click the logo.
Navigation - Projects

To edit the Survey, click a project or choose **Edit Survey** from the drop-down menu.

You can **change projects** in the upper left drop-down (#2).

Other project actions are available in the **Tools** drop-down (#4).
Project Options

In the list of projects, the **drop-down menu** allows quick access to common tasks.

You can do some of these actions from the Survey tab.

But, this is the **only** place to **share, copy, or delete** the project.
Preservation & Sharing

with yourself and those who have Qualtrics accounts
Collaboration

Everybody on a team should have separate accounts. Do **not** share passwords.

**Share the project** to give others the ability to edit the questionnaire or view the data.

Type their email in the box and click Add. Their name will pop up if they are in the same organization, but you can share with anybody unless restricted by the admin.

https://www.qualtrics.com/support/survey-platform/my-projects/sharing-a-project/
Libraries

You can store and retrieve survey elements in the various Qualtrics’ Libraries.

Your organization may have set up a shared library for you and your colleagues.

You can also store elements in your personal Library to more easily find and reuse.

Qualtrics has already stored many common survey elements in their Global Library. It has many sample surveys and special questions like lists of US States & Countries.

https://www.qualtrics.com/support/survey-platform/account-library/library-overview/
Qualtrics Library

Has entire surveys or blocks of questions.
Saving

both electronic and hard copies
Auto-saving

• Changes to your survey save **automatically**, when connected to the internet
  • If internet is lost, will display a message that it didn’t save
  • When the internet is restored, will unusually catch up.

• When changing questions, there is NO **Undo**
  • Sometimes it will save hidden answer choices, but not always
  • Always copy a question first before making changes

• When **deleting** questions, they go into a “**trash can**”
  • Scroll to the bottom to restore
Backups

Qualtrics has built-in **Version Control**:

- It will **automatically** save a "Revision" when you take a break from editing.
- You can also "Create a New Revision" **manually**, at key points, giving a description so that you can find it easily.
- When viewing a revision, you can Restore or Export it in order to create a new survey.

Please use this to backup your survey *instead* of copying it.

Making Paper Copies

Print Survey is the Participant's View

Export Survey to Word enables the Researchers View

The Participant Experience
Look & Usability
Label the right things

Do **NOT** number your questions. Participants don’t care, and get sidetracked.

Do **NOT** number answer choices unless the numbers are relevant to the respondent.

**DO** give each question a unique, useful, and uncomplicated name.

**DO** edit the question label to simplify if you will use statistical software for analysis.
Look & Feel - Themes

Themes may affect:

- Font Size
- Spacing
- Colors
- Button Style

Both Qualtrics and your Organization may have Themes. Use the drop-down boxes to switch between them.
Look & Feel – Fonts & Style

Do NOT use the **Rich Text Editor** to change normal font or font size, use **Look and Feel**.

Avoid setting font sizes in pts. Use % so people can adjust to suit their eyesight.

You can also add **Custom CSS** in the Advanced section to create classes and other elements for consistent styling.

Looks Matter

• Use your organization’s **template** if you are conducting an official survey
• Use **proper case**, not all caps or all lower case.
• Adjust length/height of **text boxes**
  • Helps participants determine what kind of information you are requesting.
  • If you have a really long box when requesting just a single number, people may think you need more
• Reduce **vertical space** where possible, adjust the margin in matrix tables

**Why?**
• It is like a **resume**. You are asking people to spend their time and energy on you.
• They care about **reputability, references**, and **attention to detail**.
• If your survey seems **important**, they will give truthful, thought-out responses.
• **Less overwhelming** surveys are more likely to be finished
• **Positive feelings** encourage completion
Organization & Flow
Best Practices: Question Ordering

✓ Start with an easy-to-answer, interesting question
✓ Keep related questions together and in a logical progression (ex. broad to narrow)
✓ Put boring, difficult, or sensitive questions at the end to avoid attrition, except if:
  • Eligibility - those who give certain answers need not finish the questionnaire
  • Logic - whether other questions should display depends on their answer
  • Human Nature - their answer might be affected by the previous questions

Recommended Block Structure:
1. Introduction / Informed Consent
2. Introductory Questions
3. Group(s) of Related Questions
4. Demographics
5. End of Survey
   • Thank participant, ask for any final comments, give a debriefing as needed

http://www.pewresearch.org/methodology/u-s-survey-research/questionnaire-design/
http://claudiaflowers.net/rsch8140/PrinciplesforConstructingWebSurveys.pdf
Moving Individual Questions

The **arrows** on the left will move an individual question one spot up or down when clicked. They appear when you hover over a question.

**Another Option:**

1. Select one or more questions and click **Move Question(s)** on the lower right
2. Move your mouse to the proper location, the blue bar shows you where it will go
3. Click your mouse on the blue bar to place it

Page Breaks

In general, you should have **1-3 questions** per page.

**Why?**

- Helps participants focus
- Less overwhelming, decreases attrition
- People don’t like scrolling
- It is too easy to skip a question when scrolling
- Answers are only saved when going to the next page. The browser could accidently get closed (or the power could go out).

**How?**

- Use **Blocks**.
- Use **“Add Page Break”**.
- Specify for the entire survey in **Look and Feel**
- Specify for a block in the **Block Options**

Encourage completion of the survey with little tweaks in the **Look & Feel** menu.

- Change the button text (e.g., “Next >>”)
- Add a Progress Bar

Going Backward

In **Survey Options**, you can enable a **Back Button**

Enable the back button *unless*:
- You are running an experiment and you need to control the experience
- You have many skips or branching logic

**Do not** ask or suggest that participants use the *back button* to review prior responses
- If you want to remind participants of previous responses, use *Piped text* or *Carry Forward Choices* instead (discussed later)

Blocks
Using Blocks

Use one **block** for each *topic, task or measure*. **Label** your blocks by clicking the default name at the top and typing.

To more easily see the overall flow of your survey, minimize a block by clicking the arrow next to the name. Or, choose “Collapse Questions” from Block Options.

Quickly Grouping into Blocks

1. Click **anywhere** within the first question rectangle to select that question and **de-select** all others.

2. Use the **checkbox** in the upper left (near the variable name) to select a second, third, etc. item.

3. With multiple questions selected, choose **Move to a New Block**

4. Click anywhere within a question to clear the selection.

Using the **checkbox** is how you select **multiple questions**. So, get in the habit of just clicking **anywhere** to **select one**.

[Link to Qualtrics support page](https://www.qualtrics.com/support/survey-platform/survey-module/editing-questions/creating-questions/#EditingMultipleQuestions)
Survey Flow shows the **overall order** of your survey by showing the blocks.

It also controls special features for blocks, like **Branch** and **Randomizer** (see later).

Moving Blocks

**Block Options** can move blocks up or down one spot. But, **Survey Flow** makes it easier. **Click and drag** on top of the *word Move* until the green bar is in the location you want.

[Image of Survey Flow interface]

Survey Flow Elements

See Distribution

See Logic - Skipping

See Logic - Randomization
Logic

Custom Survey Paths
Logic Overview

Logic refers to any survey flow actions which are based on rules or conditions. Thus, the experience of a survey can be changed for participants either randomly or depending on their responses or characteristics.

Randomization

- Randomly choose which survey elements to display
- Randomly order the displayed survey elements

Skipping or Holding

- Display or not display questions based on prior responses
- Prevent respondents from moving on if their response is invalid → See Validation

Repetition

- Display the same choices or questions a variable number of times
- Simplify the back end by repeating 1 or more questions a specific number of times

Logic - Randomization
Randomization & Experiments

Why use Randomization?

• Randomizing order can help correct for bias and human tendencies
  • For questions: answers may be affected by questions asked previously
  • For answer choices: people tend to pick the first answer choice.
    Only use this if there is no logical order for the answers.

• Randomizing display is done to improve generalization (for questions only)
  • To run an experiment and show people different things
  • The survey is really long and you don’t need all the data from each person.
    Randomly selecting the display helps retain a representative sample for each
    individual question.

You can randomly order OR display:

• Blocks within a Survey: Survey Flow Randomizer

• Questions within Blocks: Question Randomization in Block Options
  • To randomly display one question, use Advanced Randomization

• Answer Choices within Questions: Choice Randomization in Question Options

https://www.randomizer.org/links/
Answers & Questions

*Answers within a Question* = **Choice** Randomization

*Questions within a Block* = **Question** Randomization

Use Advanced Randomization to specify both **order** and **selection**.


Advanced Randomization

Questions within a block

- Random Order
- Random Display

Set Up Advanced Randomization

Note: Enabling Question Randomization will ignore page breaks, questions per page, skip logic and override question order.
Blocks within a survey

Randomly Order: Put all the blocks involved inside the randomizer, and set the number of blocks to present **equal** to the total number of blocks.

Randomly Display: Put all the blocks to choose from inside the randomizer, and set the number of elements presented to 1.

Evenly Present means to rotate the presentation of elements so it is always equal. Otherwise, it will use a random number generator. This is more random but less equal.

Logic – Skipping
Which Logic to Use?

**Skip logic** is for *screening* questions.

- Skip to the **end of the survey** if a respondent is not eligible or done with questions
- Skip to the **end of a block** if the rest of the questions in the block are not relevant.
- Use Skip Logic *only* if:
  - You need to skip over *multiple* questions based on the answer to *one* question
  - You are skipping to the **end of a block** or the **end of the survey**

Otherwise, there will be problems with skipping if you rearrange your questions.

**Display Logic** is the primary logic, which displays a question *only* if the criteria is *true*.

- **Branch Logic** is Display Logic for entire *blocks* of questions
- If your logic is based on answers to *more than one* question, you *must* use this.

  The same outcome can be achieved using different kinds of logic.

Display Logic

This is the most flexible because it is evaluated **before** something displays (should it?)

It works for:

- questions
- response choices
- matrix rows

Checking **In Page** will result in the question appearing or disappearing on the page immediately when the respondent chooses particular answers. This can clarify some questions and allow several easier questions to substitute for a more difficult one. But, it can also encourage the respondent to select the option with fewer questions.

[Display Logic](https://www.qualtrics.com/support/survey-platform/survey-module/question-options/display-logic/)
Branch Logic

This is the same as Display Logic, but for blocks of questions. Use **Survey Flow**.

A **Branch** allows you to set the conditions under which to show one or more blocks. Use the “Move” link to drag the block(s) inside the branch element.

[Image of a Qualtrics survey flow diagram showing a branch condition and two blocks: Workshop Feedback and Didn’t Go.]

[Link to Qualtrics documentation on branch logic: https://www.qualtrics.com/support/survey-platform/survey-module/survey-flow/standard-elements/branch-logic/]
Skip Logic

The least flexible logic because it is based on the answer to only one question.

It is evaluated after that question (where to go now?). You must choose the specific question to go to. If you just intend to skip over some question, use Display Logic.

Skip Logic is useful for screening questions. Use Skip Logic ONLY to:

- Skip to the end of a block. Start a block with a screening question so the respondent can go to the next block if the rest of the questions are not relevant.
- Skip to the end of the survey. Start the survey with screening questions so you can skip to end the survey if the respondent is not eligible or needed.

Logic - Repetition
Carry Forward Options

Ask about answer choices that were either selected or unselected in a prior question.

Choose to carry forward “Selected Choices” from the earlier question. Or, follow up about Unselected Choices, like “Why didn’t you use it?”

1. Use a Multiple Answer question and type in all possible answer choices.

2. Add “Carry Forward...” to the follow-up question

3. Do NOT type these in. They will automatically appear, and ONLY those that meet the criteria will show.

# Loop & Merge – What is it?

**Ask follow up questions about each choice previously selected**
- Person selects which options are relevant
- Loop for each relevant option (ignoring irrelevant ones)

**Ask questions about each item in a list**
- Person indicates how many
- Loop that many times

**Loop through each element of a pre-existing list**

> This avoids duplicating questions to see a survey's structure clearly and more easily make changes.

**Example:**
1. Which of these have you done?
2  a. What was the best part?
   b. What was the worst part?
   c. What would you change?

**Example:**
1. How many children do you have?
2  a. Gender
   b. Age
   c. Grade in school

**Example:**
1  a. Have you heard of it?
   b. Are you interested?
   c. What would you pay?

---

Loop & Merge – How to

1. Create a block for the questions that will be repeated
2. In **Block Options**, go to Loop & Merge and **Turn it on**
3. If needed, choose the question that has:
   - the selected or unselected choices to loop through and ask about
   - the value representing the number of times to loop

Loop & Merge – Piped Text

You can specify different text for each possible loop and then add it to your survey using “Piped Text”.

https://www.qualtrics.com/support/survey-platform/survey-module/editing-questions/piped-text/piped-text-overview/#PipingFromALoopAndMergeField
Creating Questions
Best Practices: Writing Questions

These are the steps respondents must go through to answer your questions. Easing this process improves data quality and avoids missing values.

Comprehension of the question
Understand the concepts, intent, and context, of the question.
Unambiguous & direct language is good for all.

Retrieval of information
Search memory or knowledge for facts or opinions.
Recalling when or how many times things happened is difficult.

Judgement and estimation
Integrate the information for judgement.
Must judge it is safe to provide answers that are socially sensitive.

Reporting an answer
Translate mental information to the given options.
It is difficult to pick from many options or make fine distinctions.

https://iriss.stanford.edu/sites/default/files/questionnaire_design_1.pdf
Questions vary on...

**Difficulty**

- **Easy** – Clear, one-topic question using simple words and grammar in which the respondent immediately recognizes the appropriate answer
- **Impossible** - A question that either doesn’t apply to the respondent, or doesn’t have an appropriate answer choice. May prompt them to leave.

→ **Note**: A single difficult question may take longer to answer than several easy questions that elicit the same information. More questions isn’t always bad.

**Interest**

- **Boring** - Routine questions, like demographics, that have automatic responses
- **Sensitive** - People will often find these interesting, but only if they are assured of anonymity or confidentiality and believe they will not be judged. If there is any possibility these could be seen as threatening, put them later.

→ **Note**: A large number of otherwise-interesting questions with the same response structure (e.g., yes/no, true/false, likert) can end up being boring.
Question Types

There are many question types. Here are the most common.

Most Common
- Descriptive Text
- Multiple Choice
- Text Entry

Also Useful
- Graphic
- Matrix Table
- Slider

Subtypes

Each major question type category has a drop-down which shows sub-types.

You can *also* get those sub-types by using the right-side options area.

Take some time to explore all the different options before making selections.

https://www.qualtrics.com/support/survey-platform/survey-module/editing-questions/formatting-questions/
Standard Types
Text Entry

Text entry is for any self-supplied values, including numbers, words, or paragraphs.

Use the **Form** style to fit several text-entry questions into a smaller space.

*Three* Text Entry Questions

Click and drag on the bottom right corner of the field to **adjust the length** of each field to match the expected answers. This helps participants understand what you expect.

[Website Link](https://www.qualtrics.com/support/survey-platform/survey-module/editing-questions/question-types-guide/standard-content/text-entry/)
Multiple Choice

You can add **Text Entry** to a multiple choice question (e.g., Please Specify)

Be sure to **adjust the width** of the text box to match the expected content.

You can also use the menu to re-order or remove answer choices.

Multiple Response

The Multiple Choice type encompasses both single and multiple response/answer questions.

**Round** radio buttons are for single answer questions.

**Square** checkboxes are for multiple answer questions.

**Multiple Answer** questions result in 1 variable *per answer choice* with a 1 representing that the box was checked and a 0 or missing meaning it was not checked.

It is always a good idea to remind people when it is a multiple answer question (e.g., “Choose all that apply”)

62
Matrix

Use the **Edit Multiple** text link in the editing pane to paste statements or values from a document. It will often ignore extra characters, so you may not have to “clean” it up or remove extra lines.

Move the **divider line** between statements and answers to reduce line breaking and minimize vertical space.

Descriptive Text

Sometimes you don’t actually have a question...

It can be useful to “introduce” a set of questions when they all relate. Or, if the topic changes suddenly.

Put descriptive text in a separate question so it is separate from your actual questions.

It can be helpful to alert the respondent when the topic of the questions changes.

Advanced Types
Slider

A slider can be useful if you require a numeric response within a narrow range, from 6 to about 20 possible values. If you have 6 or fewer possible values, a multiple-choice question is best.

Snap to Grid makes it much (much) easier to use.

During the past 3 months, how much fruit did you eat in a typical day?

Note: This is a HARD question, but a slider may make it a little easier.

Another reason to use a **Descriptive Text** question is to embed content. To display an image, choose **Graphic**. (Note: **File Upload** is for the *respondent* to upload a file)

When editing a question, choose **HTML View** to embed code, including javascript, embed syntax (e.g., videos), or style classes.

If you edit HTML directly, do not switch back to Normal view, or you might lose some of your modifications.

If you have a video, consider combining this with a timing question (see next slide)

[Image of HTML View with code example]

Hidden Questions

Browser Metadata Question

Timing Question
Use when conducting an experiment or testing materials. Notice the other features such as automatic advancement and restricting people from submitting too fast.


Other Types

**Rank Order**
Ranks are difficult to analyze with traditional statistical analyses. Use a matrix question for people to rate the responses instead.

**Side by Side**
Can be quite difficult to answer and typically unneeded in an electronic survey. Consider Loop & Merge.

**Specialty Questions**
Use these ONLY if you *must* and think ahead about how you will analyze the data.
Thinking ahead to Data Analysis
Qualtrics Analysis Tools
Content Analysis

“Tag” or code each text response.

1. Choose a Question

2. Add codes
   Click the “+” to add a new code.
   You can add more than one code.

3. View the coding
   Bar chart shows the most-used codes.
   Click on a code to filter the responses.

Crosstabulation

Choose variables for rows and columns and add %’s. Qualtrics will even calculate the chi-square statistic.

You can merge categories to better see relationships.

- **Stub = Row**
- **Banner = Column**
- **Multilevel Drill Down = Nest Variables**

Click Merge, then Save

Qualtrics Tools - Reports

You can **breakout** all results by values of a variable so you can **compare** groups.

Or, you can **filter** the results to see **only** cases with specific values in the survey metadata or from responses to questions.

https://www.qualtrics.com/support/survey-platform/reports-module/reports-overview/
Exporting
Exporting Data

What to Download

Choose to **Download Data Table** *except* if you plan to import the results back into Qualtrics (e.g., to combine surveys or transfer data from one account to another).

---

**Download Data Table**

- *Can* export custom/edited fields
- *Can* export filtered data
- *Can* customize which columns are exported and/or the order of exported columns
- *Can* export TSV file format

**Export Data with Legacy Format**

- *Cannot* export custom/edited fields
- *Cannot* export filtered data
- *Cannot* customize which columns are exported and/or the order of exported columns
- *Cannot* export TSV file format

---

*Cannot* be imported back into Qualtrics directly

*Can* be imported back into Qualtrics directly

---

The word that appears in the upper left of each question is the “Export Tag”, which serves the same function as a variable name. It does restrict you to a limited number of characters, but allows spaces and special characters (like periods) that will be replaced if exported into statistical software.

By default this will be “Q1” “Q2” etc in the order that you create questions. You can re-number questions using Auto-Number Questions on the Tools menu. When doing so, Block Numbering is typically best, but the period is not good for statistical software.

It is best to choose your own names and use numbers only within scales. This makes it easier to find the questions if you need, such as when adding logic.

In Survey Options, you can make these visible to participants. Do not do this except when pretesting the questionnaire so you can more easily discuss particular questions.
Question Labels

By default the label associated with the variable is the **entire question text**, but you can just click and change it.

If you plan to **export the data**, you should definitely change the label for **Matrix Questions**. Making it short will make the data easier to examine.

Original:

```
satisfaction_1  satisfaction_2  satisfaction_3
Are you satisfied Are you satisfied Are you satisfied
```

Shortened:

```
satisfaction_1  satisfaction_2  satisfaction_3
?-Study Areas  ?-Research Assi  ?-Availability of
```
Recode Values

If you plan to use statistical software, you may wish to change the numeric values assigned to each answer choice. Although you can use this to reverse code, consider whether it could be confusing later.

You can also change value labels, such as shortening them for better chart labels.

Matrix Question Recode Values

For Matrix and Side-By-Side questions, you can use this to change the variable name.

ex. Change the coding to have neutral be 0

ex. Make more descriptive variable names

https://www.qualtrics.com/support/survey-platform/survey-module/question-options/recode-values#QuestionExportTags
Multiple Response Questions in Data

With Multiple Answer (aka Multiple Response, MR) questions, each checkbox becomes a separate variable.

The values become:

☑ = 1
☐ = Missing (.)

q7. Which of these subjects do you like? (check all that apply)

a. ☐ Math → q7a
b. ☐ English → q7b
c. ☐ History → q7c
d. ☐ Science → q7d
e. ☐ None of these

choices are variables

For many types of analysis in statistical software, the value for non-selected items must be 0. The following SPSS syntax will fix this issue.

RECODE var1  var2  var3 (MISSING=0)(ELSE =COPY). ( or (ELSE =1). )

COMPUTE n_valid = NVALID(var1, var2, var3).
IF (n_valid > 0) var1 = (var1 = 1). (This may look weird, but it works)

Using Excel
For Excel

CSV = **Comma** Separated Values  
TSV = **Tab** Separated Values

Unless you have special characters (e.g., words from other languages), **CSV is fine**. That will usually allow you to double-click to open.

If you *do* have special characters, use TSV. You may need to choose File → Open in Excel and change the dialog box to show **All Files**.
Choice Text

**Use choice text** in all cases unless:

- You will eventually be using statistical software
- You have many ordinal variables, and the values will not be properly ordered using choice text.

Otherwise, there is no need to use numeric values to analyze data in Excel. **Pivot tables** are strongly recommended for summarizing and displaying data.

Legacy Results Format

*If* you choose Export Data with Legacy Format, you will also have the option to **Use legacy View Results format**.

That affects what metadata variables are included at the beginning of the file. The new ones have good names and are more useful.

**Checked - Legacy Results Format**

**Unchecked - Non-Legacy Results Format**
Using Statistical Software
For SPSS

If you will use SPSS, download your data in a fully-labeled SPSS formatted file.

Under **More Options**, consider:

**Recode seen by unanswered questions:**
This can be useful if people dropped out, so you can identify those who continued the survey but stopped answering.

**Export viewing order data:**
If you used randomization and care what was randomly shown or in what order, be sure to check this.
For other Statistical Software

You can open an SPSS file in Stata, SAS, and R, or convert it to many other formats using Stat/Transfer. So, download in SPSS format for all software.

If you cannot convert or want more control, you can download the syntax file.

The syntax file has the code to label the variables and values.

You can also get the datafile with just the variable names in the first row here.
Cleaning up Qualtrics’ SPSS Files

Variable Types
Text entry questions are set as nominal, but all others are set as Scale (because they have numeric response values)

Decimals
All numeric variables by default have 2 decimal points, which is unneeded for whole number codes.

Missing Values
"Exclude from Analysis" is only for analysis through Qualtrics. Currently, no user missing values are set.

Variable Names
“Illegal” characters are converted to underscores (_), so some names might be different. It is best not to use spaces or special characters.

See the previous slides on Variable and Value Labels for other tips.
Final Preparations
Final Checks

Check that the question types are correct:

- Check for **single answer** (circle) vs. **multiple answer** (square) questions
- If a multiple choice question has a few **text boxes** or one with every response:
  - Is it really a “Form” question?
  - Should you use a separate question for the explanation?
    If only some answers need explanations, use “in page” display logic

Check formatting

- Add **page breaks** to keep the participants focused.
- **Size text boxes** to match the expected responses
- Adjust **matrix questions** to reduce line breaking

Check Logic

- Check that all **logic** is the simplest type.
- Check that there are **no repeated questions** that could be in a separate block.
Validation
Validating Content

For **Text Entry** Questions only.

People often...
- misunderstand the question
- mistype (ex. type “4” instead of “44”)
- get lazy and don’t give enough information

Use **Content validation** to ensure the data you get is usable. It only applies IF a question is answered.

Be sure to think though what would be valid.
- Ensure number ranges encompass all possibilities without being overbroad (ex. for age, use 18-107). If someone is prevented from giving a truthful response by too-strict validation, they may not answer.
- If there is uncertainty, people may prefer to use words to explain (ex. does “years of schooling” include kindergarten?). Validation prevents this, so be careful.

Requiring Response

Design your web surveys to help prevent respondents from accidently skipping a question, like displaying only one or two per page and having large areas to click on.

**When to Force a Response**

- When a response is needed for logic (ex. skipping or displaying questions)
- When the rest of their data is useless without that piece of information
- Be extra careful to have an acceptable response option for every person.
- Consider adding "Don't Know" or “No Answer", but those encourage non-answers
- If you force a response with no acceptable option, your respondent may drop-out.

**When to Request a Response**

- When there is a multi-part question (e.g., Matrix, Side-by-side, Forms)
- If the page will require scrolling to see all questions (not recommended)
- When an open-ended response is not required, but especially helpful


Testing
Watch for Icons

No Options Set

Have you visited the library this semester?
- Yes, I have
- No, I have not

Validation

Have you visited the library this semester?
- Yes, I have
- No, I have not

Validation Options
- Force Response

Randomization

Choice Randomization
- No Randomization
- Randomize the order of all choices
- Present only ___ of total choices
- Advanced Randomization

Recoded Values

Recode Values
- Yes, I have
- No, I have not
It is crucial to **preview** the survey before releasing it and see how it will look both on a computer screen and a mobile device.

Click the **gear icon** to see options that make it easier to go through it multiple times. You can ignore any validation you add (see another slide) or see hidden questions.
Expert Review

You should get feedback from others on your survey. You can do any of these:

• Share the survey as if they were a collaborator. Do limit permissions.
• Copy/Send the Survey Link/URL from the preview window:
  ![Survey Link Image]
• Export Survey to Word (in Tools); it shows technical info better than “Print Survey”
• Send them a “real” survey link as if they were a participant. It is useful to enable “Show Question Numbers” in Survey Options during this testing period so you can more easily discuss particular questions (don’t forget to turn it off again).

Testing Logic

“Test Survey...” can be useful if your survey has lots of Logic.

It will help you check that it is working as planned by having a computer complete the survey. It will give random responses and then act accordingly. For instance, if a particular answer means to skip over a question, the computer will skip that question.

Handling your Test Responses

When you use **Survey Preview** or **Test Survey**, the data that is generated appears just like other responses. But, it will be identifiable as tests in the “Response Type” column.

1. Be sure to **download** your Preview and Test responses if you will use another software to analyze your data. This will give you practice downloading your data and make sure you are prepared. Downloading data does not delete it.

2. You probably want to **delete** the Previews and Tests before collecting your own data. This can be done easily from the Tools menu in the data section.

IRB Concerns
Security

Qualtrics has security.... do YOU?

With **anonymous** data, there is no confidentiality to maintain, so this is irrelevant.

If your data is **confidential**, and especially if it is sensitive, the IRB will want to know how you will maintain the security of your data in both:

- **Qualtrics.** You can link to their security statement and quote a relevant section, like "Qualtrics safeguards all customer data, and uses secure data centers to ensure the highest protection as per HITECH requirements."

- **Your computer.** Downloaded data that is not anonymous must also be kept securely. To avoid issues, you can typically choose to download a data file without the identifier variables. Or, you should immediately strip identifying information from the datafile and use only the anonymized dataset outside a secure room.
Informed Consent Agreement

- Use a **Multiple Choice** Question
- In the **Question Text**, paste your consent form
- Make the **Answer Choices** Yes/No or I agree/I do not agree
- Use **Skip Logic** to **End the Survey** if Yes/Agree is Not Selected

https://www.qualtrics.com/support/survey-platform/faqs/survey/
Distribution
Best Practices: Recruiting

*See examples from Don Dillman’s book the Tailored Design Method, available in the Digital Scholarship Center reference section. A summary is available at [http://edis.ifas.ufl.edu/pd077](http://edis.ifas.ufl.edu/pd077)*

Consider if you are trying to achieve a **random** or **representative sample** or not.

- **Representative**: A sample that has the same characteristics as a larger population.
- **Random**: The only way to use math to quantify how representative your same is.
- **Convenience**: If your sample is not representative, you can’t draw conclusions about a larger population, but you can describe your data.

Think carefully about how much to tell people about your survey ahead of time.

- People with strong opinions about the topic may be the only ones who take it, and possibly only if they think you agree with them.
- People with no pre-existing opinion may decide they shouldn’t take the survey.

Not having those types of people in your data will make it hard to draw conclusions about a population. In other words, your data will be **biased**.

[http://edis.ifas.ufl.edu/pd077](http://edis.ifas.ufl.edu/pd077)
Best Practices: Response Rate

Especially if you are doing a survey with a random sample, the response rate is just as important as, if not more important than, the total number of responses. A low rate could mean that the people who actually completed your survey are not representative of all those selected.

Pay attention to 2 factors:

- Getting people to start your survey
  - Make invitations as personal as possible
  - Make yourself seem reputable and trustworthy
  - Explain why the research will ultimately benefit them

- Getting those who start to finish
  - Start with “easy” questions, put hard or sensitive ones later
  - Start with interesting questions (e.g., not demographics)

*People will answer even long surveys if they find it interesting!*

Distributions

Click on the **Distributions** tab to see your options for data collection.

This screen appears the first time you go to that section.

[Image of the Distributions screen]

- **Identifiable Data**
  - Email
  - Web
  - Social
  - Mobile

- **Anonymous Data**
  - Get a single reusable link
  - Generate a trackable link for each contact

Methods
Methods - How To

Click on the **Distributions tab** to see your options for data collection.

This screen appears after you have selected a method.

Anonymous Data

- **Anonymous Link**
- **Emails**
- **Personal Links**
- **Social Media**
- **Offline App**
- **QR Code**
- **Purchase Respondents**

**Anonymous Data**

This helps you create a QR Code to distribute your survey. But, you can create your own.

**Identifiable Data**

- **Costs money, ask your admin**
- **Have Qualtrics find participants that meet your criteria, for a fee.**

Methods - Individual Links

With The Qualtrics Mailer

Use the "Email" section to send out your survey invitation if you have email addresses for participants and want to make use of Qualtrics’ tracking features.

Create a “Panels” and type in or import people’s email and any other information into a Panel spreadsheet. When sending the email, choose that panel.

As long as you don’t anonymize the information in the survey options, you can see who hasn’t responded and send reminders just to those people.

The default message gives you several “variables” to include the link to the survey in your email. You should use them. Just write your email around those variables.

Follow this link to the Survey:
${l://SurveyLink?d=Take the survey}

Or copy and paste the URL below into your internet browser:
${l://SurveyURL}

Follow the link to opt out of future emails:
${l://OptOutLink?d=Click here to unsubscribe}
Methods - Authenticator Value

Anonymous Link with Authenticator value. Set this up in Survey Flow.

You will send out the same [anonymous] link to everyone but ask participants to “log in” with a value you have loaded into Qualtrics (e.g., an id).

This may be a good option if you do not have email addresses, but you do have another identifier. Or, if your participants will be suspicious of “tracking links” but don’t mind entering a unique value they’ve been assigned.

Methods - Anonymous Link

This is the simplest distribution method: give the same URL to all participants.

I recommend that you leave it as a URL and not customize the link or use a shortener. This is less suspicious and makes it clear that you are using Qualtrics.

The Social Media section gives you anonymous links with embedded data (see other slide) that allows you to know which site they came from.

https://www.qualtrics.com/support/survey-platform/distributions-module/web-distribution/anonymous-link/
Features
Embedded Data

Like a hidden question, embedded data lets you set values you can use for data analysis or in question wording (e.g., Piped Text).

One use is to **track where or why** the survey was taken. When you distribute the URL, you can add information to the end (note, participants will see this), for example:

https://gmulibrary.az1.qualtrics.com/SE/?SID=SV_aWrgMsi84rjZ&workshop=stata

In **Survey Flow**, you must have Qualtrics save this information as a variable with **Set Embedded Data**. Do NOT use this method to track individuals, that is personal links.


Anonymity

In Survey Options, there is an Anonymize Responses checkbox. If your survey is intended to be anonymous, you should check this.

Anonymous Links

This will delete the respondent's IP address and location data.

Individual Links

This will also delete any connection to the contact list. You will know who has responded but not which response is from which person. However, you could probably figure it out if you wanted, so it is less trusted.

Save & Continue

Especially if your survey is long, people may want or need to stop and resume later. Find these settings in Survey Options.

Anonymous Links
Qualtrics will attempt to allow save and resume by setting a browser cookie. This is unreliable because cookies get deleted and only work from the same computer. Also avoid Prevent Ballot Box Stuffing as it is unreliable. It also uses cookies and will prevent multiple survey from being completed on the same computer.

Individual Links
Participants can easily use their personal link to resume the survey. You may want to Inform participants that responses are not saved until the page is submitted. Specify when responses will be marked completed in Partial Completion. You can also close them individually or when you deactivate the survey.

Monitoring Responses

Click **Responses in Progress** to see data that has not been recorded.

Set when they get transferred to “Recorded Responses” in **Survey Options**. With anonymous surveys in which Save and Continue is unlikely, you may want to set this to be a shorter period of time. For identifiable surveys, you may want this longer.

Final Thoughts
Be nice to the respondent

They are doing you a **favor**

by *taking* the survey

by answering each question *thoughtfully*

by answering each question *truthfully*

They **want**

to feel *valued* for their time

to feel *safe* and *secure* in their privacy

to feel like their efforts will *matter*
For more assistance...

http://dataservices.gmu.edu/software/qualtrics

http://dataservices.gmu.edu/resources/surveys

http://infoguides.gmu.edu/databooks/surveys

Created by:

Debby Kermer

dkermer@gmu.edu